Reaching All Students
Creating Inclusive Content

Lydia Frass
Tuesday, October 16, 2018

SC Technical College System

SOUTH CAROLINA




This presentation may contain
materials which have been used for
educational purposes under the “Fair

Use” exception to federal copyright
law and/or the TEACH Act and should
not be copied, downloaded, or
disseminated without proper
permission from the approprilate

copyright holder.

Unless otherwise noted, all images are in this presentation are used under
Creative Common license CCO and require no attribution.
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Outcomes

ldentify ways to make documents and videos accessible
ldentify ways to Alt Text images in documents

Discuss accessibility and virtual simulations

Discuss online course design for accessibility



Today’s Topics

Practical accessibility tips for Microsoft software
Video captioning and transcripts

Online course layout design for accessibility
Images and Alt Text

Accessibility in virtual simulations
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Accessiblility




Universal Design for Learning Guidelines

AFFECTIVE NETWORKS: RECOGNITION NETWORKS:
THE WHY OF LEARNING THE WHAT OF LEARNING

STRATEGIC NETWORKS:
THE HOW OF LEARNING

Engagement Representation

For purposeful, motivated learners, stimulate For resourceful, knowledgeable learners,

interest and motivation for learning. present information and content in different
ways.

Action & Expression

For strategic, goal-directed learners,
differentiate the ways that students can
express what they know.
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Transforming education through Universal Design for Learning — http://www.cast.org

UDL at a glance




UDL: Multiple Means of Representation




UDL Principle: Provide Multiple Means of Representation

Resourceful, knowledgeable learners
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Provide options for Perception (guidelinel)

Offer ways of customizing the display of information (checkpoint 1.1)
Offer alternatives for auditory information (checkpoint 1.2)
Offer alternatives for visual information (checkpoint 1.3)
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Provide options for Language & Symbols (guideline?2)

Clarify vocabulary and symbols (checkpoint 2.1)
Clarify syntax and structure (checkpoint 2.2)

Support decoding of text, mathematical notation, and symbols
(checkpoint 2.3)

Promote understanding across languages (checkpoint 2.4)
Illustrate through multiple media (checkpoint 2.5)
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Provide options for Comprehension (guideline3)

Activate or supply background knowledge (checkpoint 3.1)

Highlight patterns, critical features, big ideas, and relationships
(checkpoint 3.2)

Guide information processing and visualization (checkpoint 3.3)
Maximize transfer and generalization (checkpoint 3.4)
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What alternative formats for your instructional content do you
provide your students?






Document Accessibility - Word

Word

PowerPoint
Images X E
PDFs

http.://askthegeekguy. com

1

yilll|
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File -> Check for Issues -> Check Accessibility

Info

Desktop

Protect Document

Control what types of changes people can make to this document.

®

Protect
Document ~

N Inspect Document

| Before publishing this file, be aware that it contains:
Check for Revisions
Issues ~

Document properties, author's name and related dates

Inspect Document
1es are unable to read

ent for hidden properties

Check Accessibility

‘ @ Check the document for content that people
with disabilities might find difficult to read. ved changes,

'..; Check Compatibility
T | Checkf

VErSIONsS T v

« for features not supported by earlier
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| ﬂSpeCthﬂ ReSU |tS Accessibility Checker ™ %

Inspection Results

Warnings

|ﬂSp€CtiOn ReSU|tS 4 Unclear Hyperlink Text

http://www.abebooks.com/servl...
E r rO rS http://www.amazon.com/gp/pr...
. http://www.alibris.com/search/s...
Wa rn'ngs I> Objects not Inline (2)
. 4 Repeated Blank Characters
TIpS 4 Characters

23 Characters

AdditiOnal |nf0rmati0n 7 Characters

. 12 Characters
Why FIX 4 Characters

20 Characters

HOW tO F|X 6 Characters

51 Characters
Tips
Check Reading Order (2)
Additional Information v
Why Foc
Hyperlink text should provide a clear

description of the link destination
instead of providing only the URL.

How To Fix:
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Word: Heading Level Styles

AaBbCcDc AaBbCcDe | AgBb il AaBbCcl AaBbCceD

w

TMNormal T Mo Spac... | Heading 1| Heading2 Heading3 |z
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Bonus 1: Navigation Pane

Navigation ¥ X

Search document jo i
Headings Pages Results

4 Gardening
Introduction
4 History
Ancient times

The Middle Ages

- Gardening

Cottage gardens -
18th century V

Introduction
Gardening is the practice of growing and cultivating plants as part of horticulture. In gardens,

Types - ornamental plants are often grown for their flowers, foliage, or overall appearance; useful plants, such
Garden features and ac... ) as root vegetables, leaf vegetables, fruits, and herbs, are grown for consumption, for use as dyes, or for
Comparison with farmi... - medicinal or cosmetic use. Gardening is considered to be a relaxing activity for many people.

~

Gardens as art

4 Garden pests

History
Garden pest control B
Gardening department... : Ancient times
b Forest gardening, a Tree-based food production system, is the world's oldest form of gardening.[1]

Forest gardens originated in prehistoric times along jungle-clad river banks and in the wet foothills of
: monsoon regions. In the gradual process of families improving their immediate environment, useful tree
o and vine species were identified, protected and improved whilst undesirable species were eliminated.
. Eventually foreign species were also selected and incorporated into the gardens,[2]



Home Insert Design Layout References

% ) Add Text ~ ABL M Insert Endnote &

Bonus 2: Table of Contents e Tumerse o svesiomme =

Contents - Footnote Citation -
Built-In i
Automatic Table 1

Contents
LT P

HE g 3 e et s st e s s e st st cm s s s enmemee L

Automatic Table 2

Table of Contents
LT P |

LT 1 s s TOSP T SOTS SRS |

Manual Table

Table of Contents
Type chapter title flewel 1) .ot s
Ty B T B D] ) oot et et s et et ettt £t e 2

Type chapier tithe (level 3] e o m s s s s e e 3
B R T T L T . |

Tirmm rharbne FHdn lmand 90 E
E More Tables of Contents from Office.com 3
Custom Table of Contents...

E;; Rermove Table of Contents



Insert Design Transitions

Mew Table  Pictures Online Screenshot Photo Sh

P PT S | i d e Tit | eS Slide - - Pictures - Album -

Office Theme

aaaaaaa

Title Slide Title and Content Section Header
E:E' :::::::::::::E:::::::::::::\é ............................
Two Content Comparison Title Cnly
Blank Content with Picture with
Caption Caption

=] Duplicate Selected Slides
F.:‘. Shides from Outline...
= Reuse Slides...
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Reading Order

[
[
|
4
X

Slide Number Placeholder8 -
Right Arrow 7 L
Picture & SO
Picture -
Class Notebook 5
Content Placeholder 2 i
Title O

37




Reading Order (close up)

Show All Hide All

Slide Number Placehelder 8

Right Arrow 7

- Picture
"N

JA Picture 5
ClaSS NOte bOOk z:::‘njplacehclderl
Title 1

u p
i /
| . - ’ 1
j
.-r_~\ - ’
»
>
=
o §
e
=
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Microsoft Word — Tables (1)

If Only Column headings Demogriphic variable Physic(illz\,f;gig)abled. CD{QEZ%%SJ”
. . Age, M (SD) 50.8 (13.8) 51.3 (13.6)
Put cursor in column heading ce=5 cton ML) 10530 123039
Sg Bc:-:kmarnkﬂ . 2 5 55 53
Insert > Bookmark Y E— == X
" . ) M4 | ColumnTitle 114 7
Type “ColumnTitle o e | L4 >
Erl| | columnTitle_4 o To 57. 12
Press [Enter] =
. N:amle Joe Taylor Ashley
If only row headings bithdate ___[ip7e  [rsie  Lierm
. . GpA | Beckmark . @é] 25
Put cursor in row heading cell —
RowTitls|
Insert > Bookmark ,

Type “RowTitle”
Press [Enter]
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Bonus: Outline View (with titles)

7] What we see: Office 365
8 365 OneDrive

9 Waffle Menu / All Apps What we see: Office 365
10 Plan

»Summary of Tools

«OneDrive

«Other "Big Picture” Tools
*One Note
+Class Notebook ﬂ . m m
«Teams

*Word / PowerPoint / Excel
*Desktop v Cloud-based
*Share / Collaborate

Good morning, SUSAN

A

el

1 SUMMARY OF TOOLS

12 You have probably used these...
«Word
»PowerPoint
*Excel



Bonus: Outline View (without titles)

il

1

2] What Educators Need to
R What Educators
classrooms oo Need to Knoew

= With or without special
services
= Special classes

» Residential schools

= SC School for the Deaf
and Blind in Spartanburg

(General education Glassreoms
With orrwithout special SErVIGES

SPECIal GIasSes

i Residentiallschools
.Ge:em.t ;deats - S(& Sehoolienrthe beaand
« Speak directly to the BlinadNnsSpananpurg

student, not the
interpreter, if an
interpreter is used

= Try to avoid talking as
you write on the board
with your back to the Click to add notes
student







Captions

Goal is to provide equivalent
experience

Audio only files = provide transcript
Videos with audio = provide captions
Transcripts provide searchable text

Do not autostart media files; let user
control the media

Best Practice: write out your scriptin
advance!

30

4 Ch

— words came back to haunt the goth

today. Repeated across




YouTube

Go to your Video Manager by clicking your
account in the top right > Creator

Studio > Video Manager > Videos.

Next to the video you want to add captions
or subtitles to, click the drop-down menu
next to the Edit button.

Select Subtitles/CC.

Click the Add new subtitles or CC button.

Choose how you want to add or edit
subtitles or closed captions to your video

Translate Captions

Turn Captions Off

Uploa

31


http://www.youtube.com/my_videos

32




How do you use videos in your classes? Tell us about your
captioning experiences.
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Format Picture v X

Alternative text N O

Right-click the graphic > TEXT BOX
Choose “Format Picture” 4 ALT TEXT
Select “Alt Text” and add details in the Title

Description textbox

Description

A screenshot of the "Format Picture™ /
"Alt Text” pop-up window. Text is
entered in the description field
describing another screenshot on the

page.
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Example 1: Image

/cell membrane

nucleus \

5 \
\' 8 )
N\ /

cytoplasm
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Example 1: Alt Text

zeel.membrane “Animal cell diagram

nucleus‘\ displaying its cell
e membrane, the nucleus,

and cytoplasm.”

cytoplasm



Example 2: Image

Table 5. Percent of students served under
IDEA, Part B, ages 14-21 who dropped out,
graduated with a diploma, or graduated
with a certificate by race (2006)

W Dropped out Graduated with a diploma Graduated with a certificate
100% 8.56
5071 ;
BO% G2.80 63.78
4855
70% 41 82
60%
50%
40%
30%
20%
0%
American Asian/Pacific Black Hispanic White
Indian/Alaszkan Izlander
Mative

Source: L5 Department of Education, Office of Special Education Programs, Data Analysis
System, Tahle BSE.
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Example 2: Alt Text

Table 5. Percent of students served under

IDEA, Part B, ages 14-21 who dropped out, “Table 5. Percent of students served under IDEA, Part B, ages 14-21 who dropped out,

Edw:det:fdtpletgzogﬁltd ) graduated with a diploma, or graduated with a certificate by race (2006).
- American Indian/Alaskan Native, 39.25% dropped out, 50.71% graduated with diploma,
8.56% graduated with certificate.
- Asian/Pacific Islander, 14.48% dropped out, 68.89% graduated with diploma, 12.28
graduated with certificate.

- Black, 33.17% dropped out, 41.82% graduated with diploma, 23.20% graduated with

certificate.
Another Option: - His.p.anic, 33.12% dropped out, 48.55% graduated with diploma, 16.75% graduated with
certificate.
Create an - White, 21.89% dropped out, 63.78% graduated with a diploma, 12.39% graduated with a
accessible table certificate.
with this data

Source: U.S. Department of Education, Office of Special Education Programs, Data Analysis
System, Table B5B.”



xample 3: Image

PEDESTRIAN PATH

[PEDESTRIAN
REROUTING |
SIGNS WILL BE

IN

ALLED HERE |

. [Attendant 2 Area |

PEDESTRIANS WILL BE REROUTED TO
USE THE PICKENS BRIDGE

Pickens St. L
.8 3
IJ:! . . ey <
Hamilton LeConte d
v
d N Ay 0N
g 3
2 N.R.O.T.C %
Armory | Barnwell Petigru ]

Pendieton St.

—e

Bull Street

Melton = £
Observation \:

CESSIBILITY}
H

=1 ~—
&=

o O

B Fecestrian Pathway © Traffic Attendant

ssensAccessible Route
- Construction Laydown Area ¥ &
"ROAD CLOSED
. gns for Accessible Route USE PICKE 3

FOR CAMPUS
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EFxam ple 3- Alt Text “Blueprint of eastside of campus
showing accessible routes and

construction.

Piccens 57

=) Construction 1: Starting at

Pickens/Greene Streets intersection

28\ [ extending along Greene Street in

e S front of Petrigru College and stops at
=\N<ak Greene/Bull Streets intersection.

) ,..::_'Z_-:I-'f-'::'“.' T R ,c - _1| WL ‘J N
H— Pk [ I

Construction 2: Starts within the
walkway from Pendleton/Pickens
Streets between Hamilton and Sloan
Colleges and ends in front of Barnwell
College.






Types of Virtual Technology

360 Video
Augmented Reality
Virtual Reality




Creating and Using Virtual Content

Applications in healthcare, engineering, retail, public health, art,
humanities, history....
Challenges in academia
Programs that say they “won’t have disabled students”
Cost (SS and time) to purchase and/or create (both faculty and students)
Alternative assignments for students with disabilities

C
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To help those with Disabilities (and those without)

Virtual Reality, Disability and Rehabilitation

Autism, PTSD, etc.

Simulate disabilities for the non-disabled

“Second Life”

Teach empathy, cultural competencies, life skills, etc.



VR Simulation

vSim for Nursing Fundamentals

Academic Classes & Training Examples

Physics PHET
(https://phet.colorado.edu/en/simulations/cat

egory/physics)

Double Spring
(https://www.myphysicslab.com/springs/doub
le-spring-en.html)

Dental training and simulation
(https://polhemus.com/blog/entry/virtual-
reality-in-dental-training-and-simulation)

Edutopia - Schools use games for learning and
assessment
(https://www.edutopia.org/video/schools-
use-games-learning-and-assessment)



https://phet.colorado.edu/en/simulations/category/physics
https://www.myphysicslab.com/springs/double-spring-en.html
https://polhemus.com/blog/entry/virtual-reality-in-dental-training-and-simulation
https://www.edutopia.org/video/schools-use-games-learning-and-assessment
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Contact Us y
A
Lydia Frass ()
USC Center for Teaching Excellence nﬂﬂjfnm
Ifrass@sc.edu ==

UNIVERSITY OF
Susan Quinn SOUTH G’KROLINA

Division of Information Technology
susang@mailbox.sc.edu
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Resources

CAST (http://www.cast.org/)

DO-IT (Disabilities, Opportunities, Internetworking, and Technology)
(https://www.washington.edu/doit/)

USC’s Student Disability Resource Center

(https://sc.edu/about/offices and divisions/student disability resourc
e center/)



http://www.cast.org/
https://www.washington.edu/doit/)
https://sc.edu/about/offices_and_divisions/student_disability_resource_center/

s

Resources

CTE Accessibility
USC Student Disability Resource Center
Cast Universal Design for Learning: Multiple Means of Representation



https://sc.edu/about/offices_and_divisions/cte/distributed_learning/accessibility/index.php
https://sc.edu/about/offices_and_divisions/student_disability_resource_center/
http://www.udlcenter.org/aboutudl/udlguidelines/principle1#principle1_g1

